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VOLUME 4, NUMBER 10 

NEWS AND ANNOUNCEMENTS 

• ORIENTATION CLASS FOR CAMPUS NETWORK USERS 

This 1 and 1/2-hour class is for the novice network user who wants to 
learn how to use the campus network. We will cover some of the basics 
of the campus network, and you will get hands-on experience with 
network programs for terminal emulation (felnet) and file transfer 
(FIP). Attendees are welcome to bring a disk to get a free copy of 
NCSA Telnet. Here is the summer class schedule: 

Orientation for campus Network Users: Mondays, 2:00 to 3:30 pm 

IBM 
August 15 
August 29 
September 19 

Mac 
August22 
September 12 
September 26 

Our normal registration instructions apply to this class. Registration is 
not handled by the Microcomputer HelpLine; register in person at the 
ACSS Computing Information Center in 128A Lind Hall, M-F, 8 am to 
4:30pm or by mail. Oasses are filled in the order registration is 
received. The deadline for registration is 4:15pm on the last working 
day before the class begins. For additional registration information, call 
the Computing Information Center at 625-7397. If you cannot attend a 
class you have registered for, please call625-7397 to enable us to 
contact people on the waiting list. 

• NEW ffiM AND ZENITH PRODUCTS 

In the paragraphs below we've included the highlights of the IBM and 
Zenith computers which have been added to the Microcomputer Dis
count Program. You can pick up our revised IBM and Zenith Microcom
puters handout at our HelpLine. (Handouts are also available from bins 
in the hallway outside the HelpLine.) This handout includes more 
information than is given here, such as display adapter, monitor, and 
RAM expansion options, and prices for all the IBM and Zenith machines 
you can buy through the discount program. 

The standard floppy disk drive for all these new configurations is 3.5-
inch. All the new machines come with DOS, a one-year warranty, and 
at least one megabyte {MB) of random access memory (RAM). Al
though the current DOS operating systems still use only 640K of RAM, 
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REVIEW: MICROSOFT BOOKSHELF 

-~ Audio compact disks play a major role in the 
-y current recording market An audio compact 

disk holds digital information representing 
musical sounds. The popularity of the compact 

disk in the music world makes optical storage, known as CD
ROM (Compact Disk Read Only Memory), economical for 
personal computers. CD-ROM is economical because 
compact disk production costs are low, and COs can hold 
awesome amounts of digital information. One CD can hold 
approximately 600 megabytes of information (about 270,000 
pages of typewritten text). With this technology, you can store 
the resources of a small library on a CD. You can buy COs 
which provide access to vast quantities of pre-recorded 
information, such as text and digitized images and sound, 
including music. 

Information is permanently written on the CD when it is 
manufactured; CD-ROM storage is read only. This means that 
the user cannot delete, add to, or otherwise alter the informa
tion on CD-ROM disks. While, initially, it might seem odd to 
have a disk that you can only read, there are precedents. Most 
reference works are available in bound, printed copies which 
people do not deface with writing. Likewise there are many 
computer applications where the advantage of having access to 
around 600 megabytes of information on a disk outweighs the 
drawback of being unable to write to the disk. 

MICROSOFT BOOKSHELF 

Microsoft Bookshelf is one of the frrst general purpose 
applications for CD-ROM technology; it is a library of 
reference tools designed for writers. Bookshelfs CD-ROM 
includes these ten major reference works on one compact disk: 

0 The American Heritage Dictionary 
0 Rogel's II: Electronic Thesaurus 
0 The World Almanac and Book of Facts 
0 Bartlett's Familiar Quotations 
0 The Chicago Manual of Style 
0 Houghton Mifflin Spelling Verifier and Corrector 
0 Forms and Letters 
0 U.S. Zip Code Directory 
0 Houghton Mifflin Usage Alert 
0 Business Information Sources 

Bookshelf resides in your computer's RAM (random access 
memory). Because Bookshelf is a memory-resident applica
tion, you can access it while you are using another application, 
such as word processing software. Once you find the desired 
information, you can copy it and paste it in your document. If 
you just want to search for information, you can use Bookshelf 
as a stand-alone application. 

Bookshelf supports the High Sierra file formal (CD-ROM 
manufacturer's need file structures which enable you to 

quickly search through megabytes of information. One 
popular file structure is High Sierra.) 

HARDWARE REQUIREMENTS 

To use Microsoft's Bookshelf software you need: 

0 An IBM Personal Computer (or 100% compatible) that 
uses the DOS operating system, version 3.1 or later. 

0 The CD-ROM interface board and half-height, 5 l/4-inch 
disk drive and the Microsoft DOS CD-ROM Extensions 
(drivers supplied with the CD-ROM drive which allow 
you to install the CD-ROM drive as an additional drive on 
your PC). 

0 At least 512K RAM for a hard disk system or 640K RAM 
for a floppy disk system. (To use Bookshelf as a stand
alone application, you need at least 256K RAM.) 

UsiNG BooKSHELF 

Before using Microsoft Bookshelf, you must install some 
hardware inside your computer; that is, you must install the 
CD-ROM interface board and connect the CD player to the 
interface. Then you must install the CD-ROM software device 
drivers. A floppy disk containing device drivers is included 
with CD players. You can run Bookshelrs Setup program to 
install the software on your computer. If you can answer basic 
questions about your equipment, you will have no problem 
running Setup. Once you've answered its questions, Book
shelf takes over; it creates subdirectories and installs the rest of 
the Bookshelf software and makes modifications to your 
AUTOEXEC. BAT file. 

Once the program is installed, you just type BOOKS to run it 
and to make Bookshelf memory resident. Since Bookshelf is 
memory resident, you can access it at any time by hitting two 
keys simultaneously: the 0!] and the left I Shift I keys. (If your 
software already uses these keys, you can reassign Bookshelf s 
startup to other keystrokes.) You can now access any of 
Bookshelrs commands using-pull down menus with dialogue 
boxes, buttons, and entry boxes. Boo~helf provides two types 
of writing tools: Lookup tools and Reference tools. We will 
discuss these tools in the paragraphs below. 

LooKUP TooLs 

You can use the Lookup tools to check the accuracy of your 
work or to retrieve information without interrupting your work 
session. The tools in this category include: a thesaurus, 
dictionary, spell checker, usage alert, and Zip Code dictionary. 
We will briefly discuss each Lookup tool. 

Roget' s II: Electronic Thesaurus lists synonyms for words. 
While using your word processing software, you can enter a 
word in the Thesaurus dialogue box or select a word which is 
already in your document and search the Thesaurus for 
synonyms. If you find an alternative word you want to use, 
you can replace the original with the word you selected, using 
the Copy and Paste commands from Bookshelf s Edit menu. 
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The American Heritage Dictionary includes three commands: 
Word, Biography, and Geography. To use the main diction
ary, you select the Word command. The main dictionary 
includes over 200,000 words. You use the dictionary like you 
use the Thesaurus. When you look up a word in the diction
ary, you get a list of defmitions and an example of the word's 
usage in a sample sentence; in some cases you also get a list of 
synonyms and their definitions. Using the Lookup command 
is fast; it took us three seconds to fmd seven distinct defini
tions for the word effect. Each definition included sample 
sentences, a screen full of synonyms, and the defmition for 
each use of effect. The Biography section includes brief 
descriptions of lives of well known people in history. The 
Geography entries provide brief notes on significant geo
graphic locations around the world. 

Using the Houghton Mifflin Spelling Verifier and Corrector is 
easy and fast The Spell menu offers four commands: Word, 
Screen, Options, and User Dictionary. Word checks the 
spelling of a selected word. Screen lets you check the spelling 
of a screen of text Options allows you to check the entire 
document, delete repeated words, or ignore upper and lower 
case when searching. The User Dictionary option lets you add 
words to the dictionary; this option is useful because it lets you 
add words that are specific to your needs. To use the spelling 
checker from your word processing software, select the word 
in your document you want to be checked. If the word is not 
spelled correctly, Bookshelf can offer alternative spellings. 
Once you find the correct spelling, you can have Bookshelf 
replace the word with the correct spelling. 

You can use the Houghton Mifflin Usage Alert menu when 
you are unsure of the proper usage of a word or phrase, for 
example to determine whether you should use lie or lay in your 
sentence. In this case when you use Bookshelf, you are 
presented with: lie= to recline, lay= to place. Once you find 
the correct word, you can replace it in your document by 
selecting Bookshelf's Replace button. 

The U.S. Zip Code Directory is very useful if you are typing a 
letter and don't have the zip code for an address. You can 
choose Zip from Bookshelf's menu bar, type in the full address 
(street, city, and state), and in less than five seconds Bookshelf 
will display the zip code for you. We tried many addresses in 
different parts of the country: small towns, post office boxes, 
and rural routes, and except for one case, all zip codes were 
correct. You can use Bookshelf's Insert command to auto
matically insert the zip code in your document 

REFERENCE TooLs 

The second set of tools are the five reference tools. These are 
sources of information which you can search through. You 
can incorporate the results of your searches in your document 

The Chicago Manual of Style offers access to rules for good 
writing. You can instantly fmd the proper usage for parenthe-

ses or punctuation in a specific statement and make the 
necessary changes to your document. 

The World Almanac and Book ofF acts is a massive source of 
information. Here are a few topics: religion, agriculture, 
education, trade, and transportation. You may indicate one or 
more search criteria to search the almanac's index for specific 
information. Even when we indicated three search criteria 
(United States, Highest, Mountain), Bookshelf took only 25 
seconds to present the proper references to us on our screen. 

When working on a presentation or writing a letter, you might 
want to include an appropriate quotation to help make a point 
Bookshelf can come to your rescue by providing quick access 
to Bartlett's Familiar Quotations. Bookshelf lets you search 
by author or by quotes. We searched for the word wise, and 
Bookshelf presented us with the first line of over 100 refer
ences. To see the complete quote, you use the Zoom In option. 
If you find a quote that you want to include in your document, 
Bookshelf will let you paste it into your document. 

The Business Information Source is an excellent reference 
guide to government agencies, business periodicals and books, 
as well as other business-oriented information. 

The Forms and Letters tools are divided into four categories: 
Business Forms, Business Letters, Business Outlines and 
Checklists, and Personal Forms. If you are writing a letter and 
are unsure of the format, you can search for the proper format. 
When you fmd it, you can paste it into your document. 

INSTALLATION 

For this review we used a Hitachi CD-ROM player and 
connected it to these four computer configurations: 

0 Zenith Z-151 with two floppies and 256K of RAM 
0 IBM AT with 512K of RAM and a 20 megabyte hard disk 
0 IBM XT with 512K of RAM and a 10 megabyte hard disk 
0 IBM PS/2 Model 30 with 640K of RAM, a Microsoft 

mouse, and a 20 megabyte hard disk. 

With the Zenith Z-151 configuration, we installed Bookshelf 
as a stand-alone program and had no problem setting it up and 
running it We had some problems with the other configura
tions until we contacted Microsoft and Hitachi's technical 
support. We learned that the device drivers that are delivered 
with CD-ROM players are specific to your computer configu
ration. The moral to this story is that if you decide to buy a 
CD-ROM player, you must indicate what type of computer 
system you plan to use and should make sure that you are 
given the appropriate device drivers. 

On our IBM AT we configured the CD-ROM player with the 
Hitachi setup disk; but until we called for technical support, 
we were unable to install Bookshelf on our AT. In the case of 



the IBM XT, we installed the drive and Bookshelf but couldn't 
use the keyboard to defme a block of text and use the copy and 
paste option. The device drivers that were delivered with our 
CD-ROM player were set up for the IBM PS(l Model 30. 
Although those drivers support the Z-151, they do not support 
the IBM AT or other PS(l machines. The problem with the 
IBM XT was that we were using the Enhanced Keyboard. 
Once we changed the keyboard to the older style model, 
Bookshelf functioned normally. 

It took us ten minutes to install the drivers and Bookshelf on 
our PS(l Model 30, and we tested both the keyboard and 
mouse options. We found it much easier to access Bookshelf 
when we used the mouse to select information and move 
around. If you plan to use this program, we highly recommend 
that you install a mouse. 

CoMPATIBILITY 

Bookshelf supports most of the commonly used word process
ing programs available for DOS-type personal computers, such 
as Microsoft Word and WordPerfect. (The manual has a 
complete list of supported software.) We tried Word version 
4.0 as well as WordPerfect versions 4.2 and 5.0. With one 
exception, we were able to copy and paste information from 
Bookshelf into documents from both Word and WordPerfect. 
When we used WordPerfect 5.0, we couldn't use Bookshelf to 
replace misspelled words. Instead, we got the message 
"Replace disabled" whenever we tried to correct a misspelled 
word. We contacted the technical support people for both 
Microsoft and WordPerfect Neither company had tested 
Bookshelf with the newest version of WordPerfect, and they 
could not make any suggestions. 

CoNCLUSION 

This is an exciting program. Once Bookshelf was up and 
running, we had a lot of fun using it Bookshelf lets you race 
through massive amounts of information and reference 
materials looking for the right touch or final detail. Instead of 
spending hours pouring over pages of written material, you 
can ask Bookshelf to do the search in a fraction of the time it 
would take you to do a manual search. When you fmd the in
formation you need, you don't have to copy it onto paper and 
retype it into in your document Instead, you copy the infor
mation to Bookshelf's Clipboard and paste it into your 
document 

Bookshelf is an excellent tool for students, professional 
writers, businesses, or anyone who searches reference books 
for information and discoveries. If you fit any of the catego
ries mentioned, we highly recommend this program. 

Bookshelf is available for $175 through the Electtonics Desk 
at the Book Center in Williamson Hall. The Hitachi CD-ROM 
player can be ordered through AmeriData for $705. You can 
contact AmeriData at 7008 Northland Drive, phone 536-6000. 

If you want to examine Bookshelf, stop by the Microcomputer 
HelpLine for a demonstration. 

REVIEW: SOLANA R-SERVER 

The R-Server from Solana provides 
remote access to an AppleTalk network 
and can be used to bridge two AppleTalk 
networks together. The R-Server is a 

hardware device which is connected to an AppleTalk network 
with a LocalTalk or PhoneNet connector and is also connected 
to a modem or ITE phone. Communication with the Apple
Talk network is then possible by connecting to the R-Server 
through the modem. Since communication is done through 
modems, information transfer is limited to relatively slow 
speeds (1200 to 9600 baud; Apple Talk is 230,000 baud). 

In one type of remote access, two AppleTalk networks are 
bridged together. That is, each AppleTalk network has an R
Server, and the R-Servers act as bridges to link the two 
networks via modems, as shown in Figure 1. This is referred 
to as "Remote Bridge Mode" or a "Full Bridge Connection." 
When you bridge two networks, devices on both networks can 
be shared just as if they were local to the network. However, 
since communication takes place at modem speeds, this type 
of connection is unacceptably slow at 1200 or 2400 baud. AI- .._, 
though, for connections within the University, you can get 
more speed by using a 9600 baud ITE phone on each side, a 
far better alternative is to use a Kinetics FastPath to connect to 
the campus-wide Ethernet. This FastPath alternative provides 
high-speed remote access to many networks, not only on 
campus, but throughout the world. However, if Ethernet is 
unavailable, modems and R-Servers are an option. 

Figure 1: 
Remote Bridge Mode or Full Bridge Connection 

Modem Modem 

~:n'"''rn i i 
I R-Server I R-Server J 
Apple Talk Apple Talk 
Network Network 

In the second type of remote access, a single remote Macintosh 
can be connected to an Apple Talk network. The remote Mac 
is connected to a modem, and it calls the modem that is 
connected to the R-Server on the Apple Talk network, as 
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shown in Figure 2. 
This is referred to as 
"Remote Access 
Mode" or a "Half
Bridge Connection." 
In this mode, instead 
of connecting two 
networks together, 
you simply allow 
your individual Mac 
to connect to the 
remote Apple Talk 
network as if it were 
a local network. 
While communica-

Agure 2: Remote Access Mode 
or Half-Bridge Connection 

Modem Modem 
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!!Server ~ 

AppleTalk Macintosh 
Network 

tion is still quite slow compared to Apple Talk or Ethernet 
speeds, this mode lets you access your network from any 
location (such as your home) in a transparent, convenient 
manner. 

SETTING UP THE R-SERVER 

Setting up the R-Server on your network is straight-forward 
and well-described in the documentation. Solana provides an 
application which allows you to do some limited checking of 
network status and which you use to set up the R-Server with 
the proper network parameters: the network number, zone, 
and the R -Server device name. 

UsiNG THE R-SERVER 

To connect to the network from a remote Macintosh, you must 
fJrSt install the desk accessory Async AppleTalk that is supplied 
with the R-Server. Using this desk accessory, you can activate 
an AppleTalk connection via your modem much like you 
would make a connection with any communications program. 
The software can dial the phone for you if the modem is Hayes 
compatible; if you are using a campus ITE phone, you can 
manually dial. Once your connection is made, you can access 
all the devices and services of your network directly from your 
Mac just as if you were directly connected to the network. 

Well, almost. You will quickly learn that the slow communi
cation speeds severely restrict what is possible. The documen
tation even includes an appendix, "Hints and Tips," that 
suggests limits on what you attempt At 1200 baud we found 
the only practical use was to transfer files from computer to 
computer. The LaserWriter sometimes timed out before a frle 
could be transferred to it for printing; launching an application 
from a file-server will bring your computer to a halt whenever 
it accesses the file-server. Even transferring a file was slow; it 
takes nearly eight minutes to transfer a 78K file from an 
otherwise idle file-server over a 1200 baud line. At 9600 
baud, many of these problems disappeared, but we still noticed 
very slow performance relative to normal Apple Talk or 
Ethernet network speeds. 

CoNCLUSION 

At 1200 baud the R-Server provides a method to transfer files 

easily, albeit slowly, from an AppleTalk network to or from a 
remote off-campus site. With a high-speed modem on an ITE 
phone, the R-Server provides higher speed access to Apple
Talk network services and is more usable. If this service is 
important to you, the R-Server can be specially ordered. 
However, for many applications, there are better alternatives 
than an investment in the R-Server. For on-campus use, a 
Kinetics FastPath provides similar networking services, at 
much higher speeds. If you have questions about the R
Server, Kinetics FastPath, or other network services, call or 
visit the Microcomputer HelpLine. 

REVIEW: TURBO PASCAL 4.0 

Turbo Pascal from Borland for IBM-type micro
computers has been around for several years. In 
Turbo, the programmer had a very fast, very easy 

Pascal compiler. In addition, Turbo's built-in editor made life 
a lot easier for the Pascal programmer. Unfortunately, Turbo 
had drawbacks that prevented programmers from using it for 
large-scale projects. Version 4.0 of Turbo Pascal for IBMs has 
many new features that make it a serious contender in the race 
for best programming language compiler. 

This article is aimed at the reader who has seen or used the 
older versions of Turbo Pascal. In our review we will concen
trate on the new features of Turbo Pascal version 4.0. 

FASTER COMPILATION 

When Turbo Pascal was introduced, programmers were 
amazed at how quickly it compiled Pascal programs. Each 
new release has been faster, and version 4.0 compiles two to 
three times faster than version 3.0. (We compiled one 9000 
line program in 10.5 seconds with version 4.0.) To further 
improve the speed of program development, version 4.0 has a 
provision which allows you to use pre-compiled units. 

Not only is the compilation faster, but so is the execution of 
the code. The new Turbo code is more optimized and com
pact, due in part to a smarter linker. 

PRE-cOMPILED UNITS 

When you build large programs, it is now possible to break 
your Turbo Pascal program into several smaller parts. Each 
part can be separately compiled and then linked together to 
form a single program. You are not required to re-compile 
every line of your program every time you change one line. 

Precompiled units offers several advantages. The most 
obvious is faster development time. You can also conven
iently re-use code. If you build a unit that handles file 1/0 
(openftle, closeftle, readftle, .... ), you can use this code in 
different programs simply by linking in this unit This means 
you only have to write and debug the unit once. 



EDITING IMPROVEMENTS 

When you first run version 4.0 you will notice that Turbo's 
user interface has changed. The screen is divided into four 
parts, and there are five menu options across the top of the 
screen: File, Edit, Run, Compile, and Options. Since there is 
no mouse support built into Turbo, you choose commands by 
using a series of key strokes to activate the menus. Then you 
use the arrow keys to traverse the list of commands inside the 
menus. Below the Menu bar is the Edit window. Below the 
Edit window is the Output window. The bottom line on the 
screen displays the function key commands. In the following 
paragraphs we will briefly discuss each menu. 

You use the File menu to open, close, save, and view ftles. In 
Turbo 4.0 you can either type the name of the ftle you wish to 
manipulate, or you can use a series of menus (controlled by the 
arrow keys) to traverse directories and disk drives until you 
fmd and select the ftle you are looking for. The Edit menu or 
command transfers the focus of activities from the command 
menus to the Edit window. The Edit window uses the same 
commands that all the previous versions of Turbo have used. 
You use the Run command to run your program. If your 
program's been changed, Turbo re-compiles it before it is run. 

The Compile menu contains a number of commands, such as 
Compile, Make, Build, Destination, Find Error, Primary File, 
and Get Info. You use the Compile command to compile your 
program. The Make command invokes Turbo's Make 
sequence. You use Make, Build, and Primary File to condi
tionally re-compile units based on the date. This insures that 
all units your program depends upon are up-to-date. (See the 
Stand Alone Make Utility section for more information.) You 
use the Destination command to select the compilation ftle's 
destination between disk and memory. The Get Info command 
shows you size information (size of source ftle, size of . EXE 
me, available memory, etc.) about the current . PAS ftle. 

You use the Options menu to change a number of parameters 
relating to the compiler and the Turbo 4.0 operating environ
ment (directories, load and save options, and command line 
parameters). The Output window displays the output from 
your program. To scroll through this window you use your 
keyboard's arrow keys. In addition, the Output window lets 
you simultaneously look at your code and the output it 
produces. You can use this split-screen approach, or you can 
use the Zoom windows function to display the Edit or Output 
windows as a full screen. 

CoMPILATION To EXE FILES 

One of the biggest limitations of the previous version of Turbo 
was that the executable ( . COM) ftles it created were limited to 
64K of executable code. Turbo version 4.0 creates . EXE ftles 
whose size is limited only by the amount of memory DOS can 
handle (up to 640K). However, because of the segmented 
nature of the Intel microprocessor, if your program gets too 
large you may still have to break up your program into 
separately compiled units that are 64K, or less, in size. 

The same data size limits apply in Turbo 4.0 as in earlier 
versions. Static data structures are limited to 64K in length. 
Dynamic structures (pointers) can be any size, assuming they ._, 
are smaller than physical memory. 

CoMMAND LINE CoMPILATION 

Turbo 4.0 now supports command line compilation through a 
separate program: TPC. EXE. This allows you to create 
Pascal programs in your favorite editor and compile them from 
your DOS prompt. This may be useful for those of you who 
have a series of programs that you would like to compile from 
a DOS batch ftle; it is also used by the Make utility described 
below. 

STAND ALONE MAKE UTILITY 

Version 4.0 has a stand-alone Make utility. This utility will 
allow you to manage large programs that are constructed out 
of a number of smaller units, sources, and object ftles. This 
utility is similar to the Make and Build commands in the 
Compile menu, but you can add some extra commands to the 
Make ftle to keep your . ASM and . OBJ assembly language 
ftles up-to-date. 

Make checks the time that your ftles were created or modified 
and compares that to the time the ftles were last compiled. If a 
ftle has been modified without being compiled, then that ftle is 
compiled. When you use Make you are assured that all the 
different parts that constitute your program are up-to-date. ..., 

The Build command is similar to the Make command except it 
recreates all of the parts of your program without checking 
dates. 

NEW DATA TYPES 

There are several new data types that were added to Turbo 4.0: 
longint, shortint, word, and IEEE Standard 754 floating-point 
types (single, double, extended and comp) if you are using the 
math co-processor (8087, 80287, or 80387). The following 
table shows the new types and their sizes. 

TYPE MEMORY SIZE NUMBER SIZE 

longint 4-byte -2147473648 .. 2147473648 
shortint 1-byte -128 .. 127 
word 2-byte 0 .. 65535 

single 32-bit real number 10"31 •• 1Q38 

double 64-bit real number 10"31 •• 1Q38 

extended 80-bit real number 10-4031 .. 1 ()4031 
comp variable 263 •• ~1 

Co-PROCESSOR SuPPORT 

In the past Borland supplied two different compilers, one with ...., 
math co-processor support and one without. Version 4.0 
comes with integral co-processor support. 



AssEMBLY LANGUAGE INTERFACE 

Although you could call assembly language routines from 
Turbo 3.0, the method of linking them to the Pascal program 
was completely different from the conventions established by 
other manufacturers. Previously you had to assemble and link 
the Turbo assembly routines into a . COM file. Turbo 4.0 will 
now accept an assembled . OBJ file directly. 

ON-LINE HELP 

Borland has added a very nice context-sensitive on-line help 
facility. You can use the§] key to display a screen of 
information about the various Turbo commands. If you have 
pulled down a menu, when you use the§] key Turbo will 
automatically display the Help screen associated with the 
menu command that is currently highlighted. To traverse the 
Help menus, use the arrow keys. To get help on producedures 
and functions that are in your source file, place the cursor on 
the word and press the I Ctrl) and m keys. For example, if 
you are using the graphics unit, and forget the parameters for a 
certain procedure, you could turn to the Help facility. To 
display the Help entry for that procedure, place the cursor on 
the procedure name in the edit window and use the I Ct rl) and m keys. 

GRAPHICS SUPPORT 

You.can call more than 50 different graphics routines from the 
Graph unit There are new high-level procedures for fill 
polygon, lines, curves, arcs, and bitmaps. You will also find 
improved character font support for sizing, rotating, and 
drawing "stroked" characters from font files stored on disk. 
Turbo 4.0 graphics routines support these seven popular 
graphics video standards: CGA, MCGA, EGA, VGA, 
Hercules, AT&T 400 line, and 3270 PC. Each graphics driver 
is stored in a separate file. At runtime Turbo detects which 
graphics hardware is installed in your computer and automati
cally loads the appropriate graphics driver. This eliminates the 
need to re-compile your program for different hardware 
configurations. 

DOS PROCEDURES 

Borland has added a unit of commonly used DOS procedures 
that can be called from your Pascal programs. Many useful 
routines are available, including interrupt support, date and 
time, disk status, file-handling, and process-handling proce
dures. 

TuRBo 3.X CoNVERSION 

The program UPGRADE. EXE has been provided to help you 
convert existing Turbo Pascal 3.X programs to the new Turbo 
4.0. This program reads your old Pascal source file and 
performs a number of actions: 

• As necessary, UPGRADE changes the syntax to comply 
with the new compiler. 

• When syntax or runtime behavior differs from earlier 
versions, UPGRADE will insert comments in your code. 

• UPGRADE can write a separate file with detailed advice 
and warnings. 

• UPGRADE adds the appropriate unit calls from the standard 
units. 

• UPGRADE can break programs into units or separate 
compilation fragments that will optimize compilation time. 

CoNCLUSION 

Borland continues to make life easier for professional and 
amateur Pascal programmers. Version 4.0's new features add 
more power and decrease program development time, making 
Turbo Pascal well worth its $60 price tag. We consider it to be 
one of the top Pascal programming languages. For those of 
you who already own a registered copy of Turbo Pascal 
version 3.0, you can upgrade to version 4.0 for $39.95 plus $5 
for shipping. The upgrade is available directly from Borland 
International; call them at (408) 438-8400. 

NETWORK AccEss To LUMINA 

Although anyone can connect to LUMINA with a 
modem, some departments can also make a higher 
speed connection to LUMINA over the campus 

internet using the NCSA Telnet communications program. 
NCSA Telnet is copyrighted, public domain software from the 
National Center for Supercomputing Applications at the 
University of Illinois at Urbana-Champaign. 

Your department can access LUMINA using Telnet if it meets 
either of the following conditions. [ 1] Your department has an 
IBM-type microcomputer or a Mac and the machine has an 
Ethernet card that is connected to the campus internet [2] 
Your department has a LAN which supports the TCP/IP 
protocols and is connected to the campus internet. Besides 
departments, anyone who has a current Microcomputer Access 
Card can use NCSA Telnet to connect to LUMINA from the 
Macintoshes in these four public microcomputer labs: 
Folwell, Walter, McNeal, and Anderson. The following 
tutorial includes step-by-step instructions on how to connected 
to LUMINA using NCSA Telnet version 2.2. There are IBM 
and Mac versions of Telnet. 

For the curious ... you can use Telnet to connect to LUMINA 
because LUMINA is now connected to the campus internet 
Each device on the campus internet has a unique name and 
address. LUMINA's IP address is 128.101.92.3; its name is 
LUMINALIB.UMN.EDU. (For more information on internet 
IDs, see the tutorial on Network Names and Addresses in our 
July 1988 newsletter.) 

ACQUIRING NCSA TELNET 

The Microcomputer HelpLine distributes and supports NCSA 
Telnet for IBM and Macs. To obtain a free copy of the IBM or 
Mac version, you can bring a formatted disk to the HelpLine. 

t 



Mac users can also get the Mac version of Telnet from the 
Communications folder on the Mac Information Server. (The 
Mac Information Server is a public-access AppleShare file 
server that contains a variety of information. See our Novem
ber 1987 newsletter for more details.) 

INSTALLING NCSA TEL NET 
On an IBM-type machine: The IBM version of Telnet includes 

a Readme file which explains how to install the Telnet 
program onto a floppy disk or a hard disk. Essentially, you 
will copy and modify several files, such as CONFIG. TEL. 
(In order to correctly modify the CONFIG.TEL file, you 
must know your machine's IP address. If you don't know 
the IP address, contact the network administrator in your 
department who is in charge of IP addresses.) 

On a Macintosh: The Mac version of Telnet is composed of 
two files which have already been configured to work with 
the University computers. If you have a hard disk, you can 
drag NCSA Telnet 2.2 and CONFIG.TEL anywhere on your 
hard disk. If you have a system with two floppy drives, 
keep the two files together on the same disk. 

TELNET TO LUMINA 
On an IBM-type machine: Make sure you are logged onto the 

drive or subdirectory where the Telnet files have been 
copied, then type: TELNET LUMINA 

try to immediately log onto LUMINA again. We suggest you 
wait awhile before trying to log on. 

AccESSING LUMINA 
Once you have established a connection with LUMINA, you 
have a few more steps to get through before you can actually 
search for anything from the library's on-line card catalog. 

You must select a Terminal Type from the list LUMINA 
presents to you. Type the number that selects VI'l 00 from that 
list and press the !Return) or(Enterl key. 

You also must ask for LUMINA by name. Figure 2 shows you 
the instructions you will see on your screen. Remember to 
press the !Return! or[ Enter) key after you have actually typed 
lumina. 

Next you must enter a Subsystem Selection Code. Figure 3 
shows you the instructions you will see on your screen. Cur
rently you have only one choice. Type~ and press the 
!Return) or !Enter) key. 

Once you've successfully logged onto LUMINA, you will see 
a Welcome to LUMINA message. This is your introductory 
screen; you can begin your library search immediately. 

Problems 
If you don't get the messages from LUMINA we discuss 

throughout this tutorial, your On a Macintosh: Double-click 
on the Telnet icon, and wait 
about 25 seconds for the box 
which tells you about NCSA 
Telnet to disappear. Pull 
down the File menu and 
select Open Connection. You 
will see the dialog box shown 
in Figure 1. In the Session 
name box type LUMINA and 
click on the OK button. 

Figure 1: Mac Telnet- Open Connection session with LUMINA has 
probably become mangled. 
This means you must restart 
your LUMINA session. Use 
these keystrokes to begin 

Problems 
Occasionally you will not be 
able to access LUMINA because 
either LUMINA or the campus 
network are not working. 

Session name I lumina 

Window Name 

(configure) ([ OK 11 (Cancel ) 

F.gure 2: Type Lumina 

PLEASE TYPE IH LUMINA RHO PRESS ENTER 

Figure 3: Enter Subsystem Code 

recovery from a hung session 

• press the I Esc I and the ~ 
keys 

On an IBM -type machine you 
must quit Telnet before you can 
actually restart your LUMINA 
session. To quit Telnet, press 
the~ and®] keys. To 
restart your LUMINA session 
type: TELNET LUMINA 

If Telnet cannot get 
LUMINA to 
answer, you will 
get a message 
stating Host or 
gateway not re
sponding. If you 
get this message, 
you will probably 
encounter similar 
problems if you 

LIIRRRIES IF TIE UNIVERSITY IF MINNESITR INIEGRRIED NEIMIRK RCCESS 
On a Macintosh to 
restart a LUMINA 
session, pull down 
the File menu and 
select Open Con
nection. You will 
see the dialog box 
shown in Figure 1. 
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In the Session name box type LUMINA and click on the OK 
button. 

UsiNG LUMINA 
Once you are connected to LUMINA, you can search the book 
and periodical titles in the University and the Law Libraries. 

If you are using a Macintosh, you can use the NotePad, Scrap
book, or similar desk accessories to capture information you 
read on LUMINA's screen. You can use these desk accesso
ries to makes notes to yourself instead of using pen and paper. 
To capture information, select the information by dragging the 
mouse through whatever you want to copy. Use the Copy 
command from the File menu. Select the desk accessory you 
want to use from the ti menu. Finally, use the Paste command 
from the File menu. 

If you would like more information about LUMINA, see the 
LUMINA article in our June 1988 newsletter. If you would 
like a handout explaining how to use LUMINA's search 
features, go to a service desk in any of the campus libraries. 

LoG oFF LUMINA 
It is important to log off LUMINA when you have fmished 
using it. The two exit steps are shown below. If you fail to 
follow these steps, you will continue to tie up the LUMINA 
access line you are using. Initially, logging off LUMINA can 
be confusing because you do not get a "Goodbye" message. 

Whether you use an IBM-type or a Mac, the steps which 
disconnect you from LUMINA are the same. Here they are. 

• press the I Esc I and the ([J keys 
• type logoff 

QuiTTELNET 

If you are using an IBM -type machine, use these keystrokes to 
quit Telnet and return to the DOS prompt: 

• press the~ and m keys 

If you're using a Macintosh select these commands to quit 
Telnet and return to the desktop: 

• select Close Command from the File menu 
and click on the OK button 

• select Quit from the File menu 

HELP 

If you are having trouble using Telnet from a microcomputer, 
contact the Microcomputer HelpLine. To learn more about 
using networlcs and for hands-on experience using Telnet, 
attend our new Campus Network User Orientation class 
(announced on page 113 of this newsletter). 

( .. ANNOUNCEMENTS CONTINUED FROM ... PAGE 113 

OS/2 will be able to access as much as 16MB of RAM. (To 
run OS/2 Standard Edition, you need an 80286 or 80386 
machine with a hard disk and a minimum of 2 MB of RAM. 
See our January 1988 newsletter announcement for more OS(l 
information.) At press time the Microcomputer Helpline had 
already received one of these new machines. Zenith's Super
sPort 286 portable (the 20MB hard disk model) is available 
for your inspection in the HelpLine. Price and speed compari
son tables follow the new microcomputers' descriptions. 

IBM PS/2 Model 50 Z 
Like the older Model 50, the new Model 50 Zs have an 80286 
microprocessor and come with one MB RAM and one built-in 
1.44 MB floppy drive. In contrast to the original Model 50, 
the Model 50 Z has zero wait states for memory access; this 
means that the processor does not have to wait to read from or 
write to memory. Although both the Model 50 and the Model 
50 Z (the Z stands for zero wait states) run at 10 MHz, the 
50 Zs are faster because of the zero wait states and improved 
hard disk access times. The 30 MB hard disk Model 50 Z has 
39 millisecond average (ms) access and the 60 MB version has 
27 ms average access time. (The older, 20MB model has 80 
ms average access time.) Because the Model 50 Zs have faster 
average access times for the hard disk, disk operations such as 
reading and writing should be noticeably faster than the older 
Model 50. The PS/2 50 Zs include a built-in Video Graphics 
Array (VGA) display adapter, but they do not include a screen. 

IBM PS/2 Model 70 
The Model 70 is IBM's newest 80386 machine; it is like a PS/ 
2 Model 80 that sits on the desktop. The three Model 70s 
differ in their central processing unit (CPU) speed, their hard 
disk size and average access time, as well as in how much 
RAM comes on the system board. Model70-E61 runs at 16 
MHz and comes with one MB RAM and a 60MB hard disk 
with 27 ms average access time. Models 70-121 and 70-A21 
come with two MB RAM and a 120 MB hard disk with 23 ms 
average access time. Model70-121 runs at 20 MHz; while 
Model 70-A21 runs at 25 MHz, which is faster than any of the 
PS/2 Model 80s. 

All three Model 70s come with a clock/calendar, a socket for 
an optional80387 co-processor, IBM's 101-key PC keyboard, 
one 16-bit and two 32-bit expansion slots, as well as one 25-
pin serial port, one bidirectional parallel printer port, and a 
mouse port. Although the Models 70s include a built-in VGA 
display adapter, they do not include a screen. 

Zenith-248/12 
Like the older Z-248s, the new Z-248/12s have an 80286 
microprocessor with zero wait states and an Enhanced Graph
ics Adapter+ (EGA+). The new 248/12s are faster; the 12 in 
their name stands for 12 MHz (the older 248s run at 8 MHz). 
All the Z-248/12 configurations shown in the table below also 
differ from the older Z-248s in that they come with one MB 



RAM and a 1.44 MB floppy drive. The serial connector is 
still the 9-pin type. The Z-248/12 configurations in the table 
below differ in the monitors that are bundled with them. 

Zenith-286 LP 
Like the older Z-286s, the new Z-286 LPs have an 80286 
microprocessor and an EGA+ video adapter. The LP in the 
new Z-286's name stands for its low profile; it's a smaller 
machine. Although all the Z-286s run at 8 MHz, the new LPs 
are faster because they have zero wait states for memory 
access and faster hard disk access. The Z-286 LPs have a 40 
MB hard disk with 28 ms average access time (the older Z-
286s have a 20MB hard disk with 80 ms average access time). 
Other Z-286 LP changes include increases in the standard 
RAM to one MB and the standard floppy drive to 1.44MB. 
The serial connector is still the 9-pin type. The Z-286 LP con
figurations in the table below differ in their monitors. 

Zenith SupersPorts 
Zenith's new SupersPorts are portables which are available in 
80C88 and 80C286 models. The SupersPort 286 is Zenith's 
first AT-type portable; you can run it at either 6 or 12 MHz. 
You can run the 80C88 SupersPort at 4.77 or 8 MHz. The 
SupersPorts have built-in CGA display adapters which are 
permanently connected to the built-in LCD (Liquid Crystal 
Display) screen. The SupersPorts' display is an electrolu
minescent super-twist LCD with a resolution of 640 x 200. 
Colors are represented by eight gray levels. You can tilt the 
screen and adjust its brightness and contrast 

The 80C88 SupersPort comes with 640 RAM, a 3.5-inch, 
720K floppy drive, and a 26 WHr NiCad battery pack. With 
its battery pack the 80C88 floppy disk model weighs about 
12.25 pounds; the 20MB hard disk model weighs about a 
pound more. The 80C286 SupersPort 286s come with a 3.5-
inch, 1.44 MB floppy drive, one MB RAM, and a 48 WHr 
NiCad battery pack. With the battery pack both 80C286 
SupersPort models weigh about 14.5 pounds. A 20MB hard 
disk SupersPort 286 is available for your inspection in our 
HelpLine. 

All the SupersPorts use CMOS (Complementary Metal Oxide 
Semiconductor) chips to conserve power and come with a 
built-in clock/calendar, a socket for a numeric co-processor, an 
autosensing adapter/charger and detachable battery pack, and a 
connector for the AC adapter/charger. The SupersPorts come 
with these additional connectors: one unidirectional parallel 
connector; one connector for RGB color monitor; a 9-pin serial 
connector; one internal connector for memory; one internal 
connector for a modem; one connector for an external floppy 
disk drive; and a port for a separate numeric keypad. 

Prices 
In the table below, we grouped the machines by CPU. Ma
chines with 8086/8088 CPUs are IBM PC/XT-types; those 
with 80286 CPUs are IBM AT-types. The newest, fastest, 
most powerful machines are those with 80386 CPUs. Ship
ping costs are not included in the Zenith prices; contact the 

Book Center at 625-6681 for shipping charges when you 
prepare your order. 

New IBM and Zenith Microcomputers 

Machine 

8086/8088 

Hard Disk 
(Megabytes) 

Discount 
Price 

Zenith SupersPort Model2 .................. none ......... $1355 
Zenith SupersPort Model 20 .................... 20 ........... 2085 

80286 
IBM PS/2 50.031 (Model 50 Z) ................ 30 ........ $2485* 
IBM PS/2 50.061 (Model 50 Z) ................ 60 .......... 2845* 

Zenith 248/12 Model 40 .......................... .40 ........ $271 0* 
ZSA-248-40 (with ZMM-149-A) ............ .40 ........... 2815 
ZSP-248-40 (with ZMM-149-P) ............ .40 ........... 2815 
ZSC-248-40 (with ZCM-1390) .............. .40 ........... 3020 
ZSF-248-40 (with ZCM-1490 FTM) ...... .40 ........... 3125 

Zenith Z-286 LP Model40 ...................... .40 ........ $2290* 
ZSA-286-40 (with ZMM-149-A) ............ .40 ........... 2395 
ZSP-286-40 (with ZMM-149-P) ............ .40 ........... 2395 
ZSC-286-40 (with ZCM-1390) .............. .40 ........... 2610 
ZSF-286-40 (with ZCM-1490 FTM) ...... .40 ........... 2710 

Zenith SupersPort 286 Model20 ............. 20 ......... $2915 
Zenith SupersPort 286 Model 40 ............. 40 ........... 3230 

80386 
IBM PS/2 70-E61 ..................................... 60 ....... $3685* 
IBM PS/2 70-121 .................................... 120 .......... 4885* 
IBM PS/2 70-A21 ................................... 120 .......... 6865* 

• These configurations do not include a monitor. 

SPEED 
The table below compares the speed of the IBM and Zenith 
microcomputers currently available through the discount 
program. Having zero wait states means that the processor 
does not have to wait to read from or write to RAM. Machines 
which have smaller hard disk access times can read from or 
write to the hard disk faster. (Some speed ratings are unpub
lished and were unavailable to us at press time.) 

IBM and Zenith Speed Comparisons 

Model 

8086/8088 

CPU 
Speed 

Walt Hard Disk 
States Access 

IBM PS/2 25E ........................ 8 MHz ............ 0 ........ n a 
IBM PS/2 25G ....................... 8 MHz ............ 0 ........ n a 

IBM PS/2 30.002 ................... 8 MHz ............ 0 ........ n a 
IBM PS/2 30.021 ................... 8 MHz ............ 0 ........ -
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Zenith 159 Model3 ............... 4.77/8 MHz .... 0 ......... 85 ms 
Zenith ZSM-159-13 .............. .4.77/8 MHz .... 0 ......... 85 ms 
Zenith ZSC-159-13 ................ 4.77/8 MHz .... 0 ......... 85 ms 

Zenith EZ-2 ........................... 7.14 MHz ....... - ......... n a 
Zenith EZ-20 ......................... 7.14 MHz ....... - ......... -
SupersPort ............................ 4.77/8 MHz .... - ......... n a 
SupersPort #20 ..................... 4.77/8 MHz .... - ......... -

80286 
IBM PS/2 50-Q21 ................... 10 MHz .......... 1 ......... 80 ms 
IBM PS/2 50-Q31 Z ................ 10 MHz .......... 0 ......... 27 ms 
IBM PS/2 50-Q61 Z ................ 10 MHz .......... 0 ......... 39 ms 
IBM PS/2 60-Q41 ................... 10 MHz .......... - ......... 40 ms 

Zenith-248/12 ( 40 MB) .......... 12 MHz .......... 0 ......... 28 ms 
Zenith-248/12 (80MB) .......... 12 MHz .......... 0 ......... 28 ms 
Zenith-248/12 (160MB) ........ 12 MHz .......... 0 ......... 18 ms 

Zenith-286 LP ....................... 8 MHz ............ 0 ......... 28 m s 
SupersPort 286 #20 .............. 6/12 MHz ....... 0 ......... 28 ms 
SupersPort 286 #40 .............. 6/12 MHz ....... 0 ......... 28 m s 

80386 
IBM PS/2 70-E61 .................. 16 MHz .......... 0-2 ..... 27 ms 
IBM PS/2 70-121 ................... 20 MHz .......... 0-2 ..... 23 ms 
IBM PS/2 70-A21 .................. 25 MHz .......... 0-2 ..... 23 ms 

IBM PS/2 80-Q41 ................... 16 MHz .......... - ........ .40 ms 
IBM PS/2 80-Q71 ................... 16 MHz .......... - ......... 30 ms 
IBM PS/2 80-111 ................... 20 MHz .......... - ......... 28 ms 
IBM PS/2 80-311 ................... 20 MHz .......... - ......... 23 ms 

Zenith Z-386 Model40 .......... 16 MHz .......... 0 ......... 40 ms 
Zenith Z-386 Model80 .......... 16 MHz .......... 0 ......... 40 ms 

• FILE TRANSFER AT THE MICRO HELPLINE 

The Microcomputer HelpLine now offers free, self-service, 
microcomputer file transfer to and from campus mainframes, 
including mainframes operated by ACSS, SPCS, and Health 
Sciences. With this service you can transfer files at speeds up 
to 1000 times faster than was possible with the fastest modem 
service at 9600 baud. That means that a file which used to 
take 20 minutes to transfer can now be transferred in about one 
second. 

We have dedicated a Macintosh with an 800K floppy drive 
and an IBM-type machine with 5 1/4-inch 360K and 1.2MB 
drives, and a 3 1/2-inch drive for this file transfer service. If 
others are waiting to use these dedicated machines, your time 
on the machine will be limited to 15 minutes. It goes without 
saying-but we'll say it anyway-that you will need an 
account on the mainframe you're accessing and that you must 
provide your own disks. 

If you would like to learn more about using the network, we 
invite you to register for our new class (announced on page 
113 of this newsletter), Campus Network User Orientation. 

MA MicRo NoTES 
e ExcEL AND MEMoRY 
The average Excel spreadsheet isn't large enough to cause out
of-memory errors. However, some Excel users do have 
memory problems. If you are using a Macintosh and having 
memory problems, here's some background information and 
some suggestions which might help you overcome memory 
limitations. Excel 1.04 resides in the first megabyte of RAM 
(random access memory). This means if your System file is 
fat with fonts and desk accessories, you have less RAM 
workspace for Excel. If you give Excel more RAM, it can 
work with bigger spreadsheets or let you work on more 
spreadsheets simultaneously. 

Memory Solutions 
Unless you use MultiFinder, Excel cannot use memory beyond 
the first megabyte of RAM. Nevertheless, if you are not 
using MultiFinder but are getting memory errors, there are two 
things you can do: (1) Set the RAM Cache option on the tt 
Control Panel to the off position and (2) make your System 
file leaner. To get a leaner System, use Apple's Font/DA 
Mover to remove fonts and desk accessories (DAs) which you 
never use or infrequently use. 

If you are using MultiFinder and are getting memory errors, 
you may still want to follow the suggestions in the paragraph 
above. If those steps don't solve your memory problem, 
here's an additional consideration. MultiFinder loads Excel in 
272K of RAM. If you work with larger than average spread
sheets, you should tell MultiFinder to increase Excel's 
memory size. To do this you must quit Excel and select the 
Excel icon from the Finder's menu. From the desktop, select 
the Get Info option from the File menu. Then type in a larger 
amount of RAM, for example 500, into the Application 
Memory Size box. 

Buy Additional Memory? 
Should you buy additional memory? With MultiFinder extra 
memory can be an advantage, especially if you want to use 
other programs (such as your word processing software) while 
you use Excel. .Just remember to start up Excel first. This 
allows Excel to claim the frrst megabyte of RAM and lets your 
word processing software load into the extra memory. (Don't 
worry about the System and Finder; they automatically load 
into the high end of memory. This arrangement leaves more 
RAM for Excel.) If you use MultiFinder you can see a dia
gram of the memory allocation for the System, Finder, and 
your applications. To do this select About the Finder ... from 
the tt pull-down menu. 
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